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1. 緒言 

1-1 椎間板 

現在、椎間板の疾病が原因となる腰痛や下肢の痺れなどの症状に苦しむ人々

が多数存在している。その一方で椎間板の疾病は現行の治療法では完全に修復

させることは困難とされている。 

 

1-1-1 椎間板（IVD）の構造 

椎間板は腰椎の椎骨の間に存在する支持組織で、椎骨にかかる衝撃を軽減す

る役割を果たしている。また、関節軟骨を形成することで椎骨の細やかな動きを可

能にし、靭帯とともに脊椎を保持する役割をもっている。 

  

椎間板の模式図を Figure 1-1に示す。 

 

 

Figure 1-1 椎間板の模式図 

 

椎間板は中央部分に水分を豊富に含む髄核（nucleus pulposus; NP）が存在し、

その周りを繊維軟骨が同心円上に層状に重なった線維輪（annulus fibrosus; AF）が

取り囲んだ構造を持つ。椎間板は無血管組織であり、損傷した時にきわめて修復、

再生しにくい組織として知られている。 

  

脊髄 

椎体 

椎弓 

椎骨 

椎間板 

髄核 

線維輪 

椎間板 
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1-1-2 髄核（NP）の構造 

椎間板を構成する組織のうち、本研究では髄核に着目した。 

髄核は髄核細胞とその細胞外基質（extracellular matrix; ECM）から構成される

水分を豊富に含んだゲル状の組織である。 

髄核組織の模式図を Figure 1-2に示す。 

 

Figure 1-2 髄核の ECM 

 

 

【髄核細胞】 

髄核細胞は髄核を形成する ECMを産生する役割をもっている。In vitroでは通

常のプレート上で培養すると脱分化し、髄核細胞の表現型を示さなくなることが知ら

れており、髄核細胞は単層培養を行うことで基質である Type II collagenおよび

aggrecanの mRNA発現量が減少することが報告されている[1]。 
 

Table 1-1 単層培養による髄核細胞の脱分化[1] 

 

  

髄核細胞 

プロテオグリカン 

2型コラーゲン 

ヒアルロン酸 
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Figure 1-3 に示すように、髄核細胞は単層培養により髄核細胞の基質産生に必

須な転写因子である Sox9の発現量が減少すると報告されている。Primaryと比較し

て Passage 1以降は全て有意に減少しており、P3以降は 1/100未満の発現量に減

少している。髄核細胞は単層培養を行うと早い段階で脱分化が進むと考えられる。 

 

 

Figure 1-3 単層培養による SOX9発現量の変化[2] 

 

脱分化状態の髄核細胞が分化状態へと変化することを再分化と呼ぶ。 
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1-1-3 グリコサミノグリカン 

Figure 1-2のプロテオグリカンはコアタンパク質にグリコサミノグリカンと呼ばれる

硫酸化多糖が共有結合している糖タンパクで、髄核組織の ECM中に多く存在する。

髄核組織中のプロテオグリカンの大半は aggrecanであり、ヘパラン硫酸プロテオグ

リカン（HSPG）である perlecan も存在している。Aggrecanに結合するグリコサミノグリ

カンの多くはコンドロイチン硫酸である。 

 

 グリコサミノグリカン（glycosaminoglycan; GAG）はアミノ糖とウロン酸の繰り返し構

造からなる硫酸化多糖であり、大部分がプロテオグリカンの糖鎖として存在する。主

に結合組織の細胞により産生されるが、存在部位により異なる構造のものが存在す

ることが知られている。 

 グリコサミノグリカンは骨格構造や硫酸基の部位により様々な名称に分類され、髄

核組織ではコンドロイチン硫酸が多く産生されることが知られている。Figure 1-4a～

1-4cにグリコサミノグリカンの一例を記す。 

 

 

Figure 1-4a コンドロイチン硫酸[3] 

 

 

Figure 1-4b ヘパラン硫酸[3] 

 

 

Figure 1-4c ヘパリン[3]  R=SO3- 

R=SO3- 

R=SO3- 
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 グリコサミノグリカンは、硫酸化部位と生理活性タンパク質との相互作用による吸

着能を有し、細胞の接着、増殖、分化など様々な現象に関わっていると考えられて

いる。グリコサミノグリカンの硫酸化率および硫酸化部位の違いなどによる構造の違

いは、様々な生理活性タンパク質に対する特異的な結合に関与すると考えられて

いる。また、髄核組織内においては保水性の維持も担っている。 

 

1-1-4 椎間板ヘルニア 

 椎間板の主な疾病に椎間板ヘルニアが挙げられる。線維輪に亀裂が入り、内部

の髄核が後方に突出したものを椎間板ヘルニアと呼ぶ。加齢による変性や強い外

力を原因とし、突出した髄核が神経根を圧迫することにより腰痛や下肢の痺れ、膀

胱障害などの症状を引き起こす。 

Figure 1-5 椎間板ヘルニア 

 

 

1-1-5 現行の治療法および問題点 

現行の椎間板ヘルニア治療は、保存療法と手術療法の 2つが存在する。 

保存療法は軽度の場合に行われ、神経に局所麻酔を浸透させ痛みを緩和する

神経ブロック、鎮痛剤の服用、コルセットの着用、マッサージなどの理学療法などが

挙げられる。 

手術療法は保存療法で効果が得られない場合や緊急を要する場合に行われる。

患部を背中側から切開しヘルニアを切除する後方椎間板切除術、金属などで椎間

を固定する椎間固定術などが挙げられる。近年では背中を切開せずにヘルニアを

切除する顕微鏡下椎間板ヘルニア摘出術や内視鏡下椎間板ヘルニア摘出術など

より低侵襲な治療法も行われているが、主な罹病者である高齢者には依然として手

術による身体的負担は大きい。 

また、いずれの治療法も椎間板の損傷そのものを治癒することはできないため再

発のおそれが伴うという問題点が存在する。 

椎弓 

神経根 

髄核 線維輪 
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1-2 再生医療 

 現行の治療法における問題点から、低侵襲でヘルニアの根本的原因である椎間

板の損傷を修復する治療法の確立が必要である。そこで有効なのが、欠損した組

織を自己の有する再生能力により機能を回復させる再生医療である。本研究では

椎間板を構成する髄核組織に着目し、髄核の再生を目的とする。 

 

1-2-1 椎間板ヘルニア治療としての再生医療 

 椎間板ヘルニアの再生医療のアプローチとしては、患部の組織から単離した細

胞のうち正常なものを in vitroで培養・増殖させ、患部へインジェクトすることで組織

の修復を促す方法が有効であると考えられる。しかし、前述のとおり髄核細胞は単

層培養により脱分化することが知られており、通常に培養を行うだけでは再生医療

に用いることはできない。 

 

1-2-2 椎間板修復材料としてのインジェクタブルゲル 

本研究で目標とする治療法は、in vitroで増殖させた髄核細胞を足場材料に混

和させて患部にインジェクトし、髄核細胞の再分化および基質産生を促進させて損

傷した髄核組織を再生させる方法で、従来の手術療法と比較して低侵襲な治療法

である。このような再生医療に用いるための材料として必要な条件は以下の通りで

ある。 

1. 増殖と同時に脱分化を起こした髄核細胞を再分化誘導できる。 

2. シリンジを用いてインジェクトが可能な流動性を持つ。 

3. 生体に対して毒性を持たない。 

 

このような条件を満たす材料開発のアプローチとしては、様々な生理活性タンパ

ク質との結合能を持つグリコサミノグリカンと同等の機能を有する材料を用いて髄核

細胞の培養を行うことで髄核組織修復材料の開発が可能になることが期待される。

また、髄核細胞は三次元足場での培養により脱分化が抑えられるという報告[4]があ

ることから、三次元の足場材料が望ましい。 

そこで、本研究では、 

1. 生体適合性を有する 

2. グリコサミノグリカン様の基本骨格を有する 

3. ゲル化能を有する 

以上 3点の条件を満たす多糖類として、ネイティブ型ジェランに硫酸基を導入し

た硫酸化ネイティブ型ジェラン、および脱アシル型ジェランにカルボキシメチル基を

導入したカルボキシメチルジェランを選択した。 



7 
三重大学大学院 工学研究科  

 

1-3 ジェラン 

ジェラン(Gellan)は Shpingomonas elodea という微生物が菌体外に産出する多糖

類で、増粘安定剤として各種食材に幅広く使用されている[5]。また、以前の研究か

ら優れた生体適合性を有する抗血栓性材料であることが報告されている[6-8]。 

 

1-3-1 ネイティブ型ジェラン（NG） 

ネイティブ型ジェラン(Native type Gellan; NG)は直鎖状のヘテロ多糖類であり、

1,3-β-D-グルコース、1,4-β-D-グルクロン酸、1,4-β-D-グルコース、1,4-α-L-ラムノース

の 4糖の繰り返し構造からなり、1,3-β-D-グルコースの C-2位にグリセリル基、C-6位

が 1/2の割合でアセチル基により修飾された構造を持つ。 

 

 

Figure 1-5 ネイティブ型ジェランの構造 

 

1-3-2 脱アシル型ジェラン（DG） 

脱アシル型ジェラン（De-acyl type Gellan; DG）はネイティブ型ジェランのアセチ

ル基とグリセリル基を取り除いたものである。カチオン類の存在下で透明のゲルを

形成する。 

 

Figure 1-6 脱アシル型ジェランの構造 

  

1,3-β-D-グルコース 1,4-β-D-グルクロン酸 1,3-β-D-グルコース 1,4-α-L-ラムノース 
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1-3-3 硫酸化ネイティブ型ジェラン（GS） 

硫酸化ネイティブ型ジェラン(Native type Gellan Sulfate; GS)はネイティブ型ジェ

ランをクロロスルホン酸と反応させ硫酸基を導入した硫酸化多糖類である。硫酸化

を行うことで生理活性タンパク質と結合能を持つようになり、以前の研究からテネイ

シン-C(Tenascin-C; TN-C)や塩基性線維芽細胞増殖因子(basic fibroblast growth 

factor; bFGF)と高い親和性を持つことが報告されている[6,7]。これら 2つのタンパク

質は創傷治癒過程や軟骨修復過程における発現が確認されている[9]。 

 

Figure 1-7 硫酸化ネイティブ型ジェランの構造 

 

1-3-4 カルボキシメチルジェラン（CMG） 

カルボキシメチルジェラン（Carboxymethyl Gellan; CMG）は脱アシル型ジェラン

の水酸基をカルボキシメチル基に置換したものである。濃アルカリ中で脱アシル型

ジェランとモノクロロ酢酸を反応させることで得られる。特徴として高い水溶性を持ち、

温度に依存せず化学架橋によりゲル化させることが可能である。 

 

Figure 1-8 カルボキシメチルジェランの構造 

 

硫酸化ネイティブ型ジェランは水溶性が高く、ゲル化能を持たないため、足場材

料としての利用はできない。本研究では足場材料としてカルボキシメチルジェランを

用いた硫酸化ネイティブ型ジェラン固定化カルボキシメチルジェランゲルを作製し

実験を行った。 

  

R=SO3- or H 
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1-4 目的 

1-4-1 目的 

 本研究の目的は、硫酸化ネイティブ型ジェラン固定化カルボキシメチルジェラン

ゲル（GS-CMGゲル）を用いて椎間板組織再生を可能とするインジェクタブルな材

料を開発することである。 

 

 

1-4-2 実験項目 

 実験は以下の項目で行った。 

1. インジェクタブルゲル材料の作製 

 カルボキシメチルジェラン（CMG）の作製 

 硫酸化ネイティブ型ジェラン（GS）の作製 

 GS-CMGゲルの作製 

 

2. 単層（2D）培養における GS添加による髄核細胞の応答評価 

 遺伝子発現の測定 

 sGAG産生量の測定 

 

3. GS-CMGゲル内（3D）培養における髄核細胞の応答評価 

 培養容器の作製 

 遺伝子発現の測定 

 sGAG産生量の測定 
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2. 実験方法 

2-1 インジェクタブルゲル材料の作製 

2-1-1 CMGの作製 

 本研究において足場材料として使用する CMGの作製を行った。 

 

【試薬】 

 脱アシル型ジェラン（DG）  （和光純薬工業株式会社） 

 水酸化ナトリウム   （和光純薬工業株式会社） 

 モノクロロ酢酸ナトリウム  （和光純薬工業株式会社） 

 

【使用器具】 

 電子天秤（SHIMADZU） 

 凍結乾燥機（LABCONCO） 

 薬さじ 

 薬包紙 

 ビーカー 

 乳鉢 

 乳棒 

 ナスフラスコ 

 ガラスフィルター 

 耐圧瓶 

 スターラー 

 撹拌子 

 エバポレーター（TOKYO RIKAKIKAI） 

 透析チューブ（三光純薬 分子量区画 14,000） 

 

【手順】 

① DG5gを乳鉢で 10分間すり潰した。 

② 50wt%の水酸化ナトリウム水溶液を調整した。 

③ 氷浴中で DGに水酸化ナトリウム水溶液を 50mL加え、10分間撹拌した。 

④ 室温で 1時間静置し DGを十分に膨潤させた。 

⑤ その後、氷浴に移し、モノクロロ酢酸ナトリウム63g（DGの水酸基に対して7倍量）

を少量ずつ加え、均一になるように撹拌した。 

⑥ 均一になった後に室温で 2時間撹拌した。発熱した場合は氷浴で冷却し、再び

室温で撹拌した。 

⑦ 撹拌終了後に試料をビーカーに移し、脱イオン水に溶解した。 

⑧ 完全に溶けたら透析チューブに注ぎ、脱イオン水で透析した。透析は透析外液

が中性になるまで行った。 

⑨ 透析終了後、エバポレーターで濃縮した後にガラスフィルターで濾過し、不溶

物を取り除いた。 
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⑩ 透析した溶液を耐圧瓶に移し、凍結乾燥させた。 

⑪ 乾燥終了後、スターラーと撹拌子でパウダー状になるまで撹拌した。 

 

2-1-2 1H-NMRによる CMGの置換度測定 

 1H-NMRにより作製した CMGの置換率を測定した。 

 

【試薬】 

 カルボキシメチルジェラン（CMG） （2-1-1 より作製） 

 D2O    （和光純薬工業株式会社） 

 

【使用器具】 

 JNM-500型 核磁気共鳴装置  （JEOL株式会社） 

 NMR test tube    （和光純薬工業株式会社） 

 Win Alpha (Ver. 1.0) FTNMRデータシステム （JEOL株式会社） 

 ピペットマン 

 電子天秤     （SHIMADZU） 

 

【手順】 

① CMG15mgを D2O0.7mLに溶解し、サンプル管に高さ 4.2cm まで入れた。 

② 下記の測定条件で測定を行った。 

 

【1HNMR測定条件】 

設定方法: 1HNMR基本設定 

実験モード: SINGL 

照射モード: NON 

SCANS: 100 

溶媒: D2O 
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2-1-3 NGのフリー化 

 多糖類を利用するためにはそれを溶媒に溶解させる必要がある。ネイティブ型ジ

ェランは構成するグルクロン酸のカルボキシル基がカリウム等の金属と塩を形成して

いるため溶媒への溶解性が低下している。そこで本項では、ネイティブ型ジェラン

の溶媒への溶解性の向上を目的としてグルクロン酸のカルボキシル基から塩を取り

除くフリー化を行った。 

 

【試薬】 

 ネイティブ型ジェラン（NG）  （三栄源エフ・エフ・アイ株式会社） 

 塩酸    （和光純薬工業株式会社） 

 アセトン    （和光純薬工業株式会社） 

 

【使用器具】 

 1000mLセパラブルフラスコ 

 撹拌機 

 撹拌棒 

 スタンド 

 クランプ 

 クランプホルダー 

 氷水 

 薬包紙 

 pH メーター 

 ブフナーロート 

 アスピレーター 

 凍結乾燥機 

 スパチュラ 

 恒温槽 

 スターラー 

 スターラーチップ 

 塩化カルシウム管 

 ピペッター 

 ピペット 

 ビーカー 

 二方コック 

 2Lマイヤーフラスコ 

 ジムロート管 

 脱イオン水 

 パラフィルム  
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【実験方法】 

①  1,000mLセパラブルフラスコに 800mLの脱イオン水を入れた。 

② ネイティブ型ジェラン 8.0gを脱イオン水に溶解させ 70℃で 20時間撹拌した。 

③ 撹拌終了後、溶液が pH3.0以下になるまで 1Nの塩酸を加えた。 

④ pH3.0以下になったら撹拌しながら室温まで冷却した。 

⑤ 冷却後、反応溶液をアセトンに滴下し再沈殿させた。 

⑥ 再沈殿後、沈殿物を濾過し、得られた沈殿物を凍結乾燥により精製した。 

⑦ 得られたフリー化ネイティブ型ジェラン（FNG）はミキサーおよび乳鉢で粉末化

した。  
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2-1-4 GSの作製 

 ネイティブ型ジェランの遊離の水酸基に対して硫酸化を行うことでネイティブ型ジ

ェランに硫酸基を導入した硫酸化ネイティブ型ジェラン(GS)の調製を行った。硫酸

化反応は N,N-ジメチルホルムアミド(DMF)を溶媒、クロロスルホン酸を硫酸化剤に

用いた。 

 

 

【試薬】 

 フリー化ネイティブ型ジェラン（FNG） （2-1-3 より作製） 

 N,N-ジメチルホルムアミド(DMF) （和光純薬工業株式会社） 

 クロロスルホン酸   （和光純薬工業株式会社） 

 塩化カルシウム   （和光純薬工業株式会社） 

 アセトン    （和光純薬工業株式会社） 

 

【使用器具】 

 300mLセパラブルフラスコ 

 撹拌機 

 撹拌棒 

 窒素混入ゴム風船 

 スタンド 

 クランプホルダー 

 氷水 

 ピペッター 

 薬包紙 

 pH メーター 

 ガラスフィルター 

 アスピレーター 

 ロート 

 凍結乾燥機 

 スパチュラ 

 恒温槽 

 撹拌子 

 スターラー 

 ジムロート 

 クランプ 

 塩化カルシウム管 

 ピペット 

 ビーカー 

 二方コック 

 2Lマイヤーフラスコ 

 エバポレーター 

 脱イオン水 

 透析チューブ 

 パラフィルム  
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percolation 

lyophilization 

0℃, 20min 

【実験方法】 

① セパラブルフラスコに蒸留した DMFを加え、セパラブルフラスコの口の片方に窒

素を含有させたゴム風船を、もう片方には頭部に塩化カルシウム管をつけたジムロ

ートをつけ窒素置換をし、恒温槽(0℃)で 20分撹拌した。 

② 撹拌終了後、クロロスルホン酸を GSの水酸基に対して 5倍量加えて 20分撹拌し

た。 

③ 撹拌終了後、FNGを加えて 20時間撹拌した。 

④ 所定の反応開始温度（Figure 2-1の t1（℃））まで温度を上げ、20分撹拌した。 

⑤ 所定の反応温度（Figure 2-1の t2（℃））に温度を設定し、2時間撹拌した。 

⑥ 0℃で 20分撹拌したのち 2M 水酸化ナトリウム水溶液を撹拌させながら滴下し中

和した。 

⑦ pH試験紙で反応溶液の中和を確認後、スターラーで撹拌しながらアセトン

(500mL～1,000mL)中に滴下し、再沈殿させた。 

⑧ ガラスフィルターで沈殿物をろ過し、得られた沈殿物を脱イオン水で再溶解させ

た。 

⑨ あらかじめ脱イオン水で洗浄しておいた透析チューブに再溶解液を移し、脱イオ

ン水で 3～4日間透析を行った。 

⑩ 透析終了後、透析液を再度ガラスフィルターに通し、濾過を行った。 

濾過後、濾液に対し凍結乾燥を行いGSを精製した。濾液が大量の場合はエバポ

レーターを用いて 200～300mLほどに濃縮した後凍結乾燥を行った。 

 

 

 

 

 

 

Figure 2-1 硫酸化ネイティブ型ジェランの調製方法 

 

 

Table 2-1 GSの作製条件 

Entry Free NG(g) クロロスルホン酸(mL) 反応温度 t1, t2(℃) 

1 1.00 3.75 70, 50 

2 1.00 3.75 80, 60 

 

  

反応開始温度(t1), 20min 反応温度(t2), 2h 

2M NaOH 
GS 

DMF 
0℃, 20min 

ClSO3H 

0℃, 20h 

Free NG 
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2-1-5 酸素フラスコ燃焼法による GSの硫酸化率測定 

酸素フラスコ燃焼法は、吸収液で湿らせた燃焼フラスコ内で試料を燃焼させ、生成

ガスを液中に吸収させ、その検液の成分を分析する方法である。分析方法は様々で

あるが、本実験では滴定による分析を行った。 

 

【酸素フラスコ燃焼法の原理】 

BaCl2 + DMSIII（赤紫色） → DMSIII-BA錯体（青紫色） 

DMSIII-Ba錯体 → BaSO4 + DMSIII（赤紫色） 

 

【試薬】 

 ジメチルスルホナゾ–III  （和光純薬工業株式会社） 

 無水塩化バリウム   （和光純薬工業株式会社） 

 硫酸（精密分析用）   （和光純薬工業株式会社） 

 30%過酸化水素水   （和光純薬工業株式会社） 

 エタノール（99%, 50%）  （和光純薬工業株式会社） 

 水酸化ナトリウム（特級）  （和光純薬工業株式会社） 

 

【使用器具】  

 FHO-A型フラスコ （浜田理科） 

 100mLビーカー 

 パスツールピペット 

 試料秤量用ろ紙 

 ガラスピペット 

 ガスバーナー 

 ビュレット 

 ワニ口クリップ付きコード 

 氷水 

 pH メーター 

 スターラー 

 パラフィルム 

 スライダック 

 50mL メスフラスコ 

 スパチュラ 

 サンプル瓶 

 O2ガスボンベ 

 撹拌
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【関連試薬の調製】 

 0.1% ジメチルスルホナゾ–III溶液 

ジメチルスルホナゾ–III(50.0mg)を脱イオン水(50.0mL)で溶解した。 

 0.02M 水酸化ナトリウム水溶液 

水酸化ナトリウム(80.0mg)を脱イオン水 (100.0mL)に溶解した。 

 50%エタノール溶液 

99%エタノールと脱イオン水を 1:1の割合で混合した。 

 

【0.005M塩化バリウム水溶液の調製と力価(factor)の測定】 

① 塩化バリウム（無水）1.0412gを取り、1,000mL メスフラスコに入れ脱イオン水で正

確に 1,000mLにした。 

② 精密分析用 1N硫酸 1.0mLを 100mL メスフラスコに入れ、50%エタノールで正確

に 100mLにした。 

③ ②で調製した 0.01N硫酸 3.0mLに 5%エタノール 17.0mLを加え 20mL とし、サン

プル瓶に入れた。これを 3本用意した。 

④ ③で調製した溶液に指示薬の0.1% dimethyl sulfonazo – IIIを 2滴加え、0.005M

塩化バリウム水溶液で滴定した。 

⑤ ブランクとして 50%エタノール 20.0mL も同様にして滴定を行った。 

⑥ 硫酸－エタノール溶液の平均値滴定量からブランク平均的定量を差し引いた値

を正味の滴定量とし、力価（factor）を算出した。 

 

0.005M塩化バリウム水溶液 1.0mLは硫黄 0.1603gに相当することから、Factorは得ら

れた結果を式(1)に代入することにより求めた。 

S(%) =
滴定量(mL) × factor × 0.1603

sample量(mg)
× 100   (1) 
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【酸素フラスコ燃焼法の実験方法】 

① 試料秤量用濾紙の作製。直接手で触れないようにろ紙をはさみでカットした。 

② カットした濾紙の上に sampleを 20.0mg量り取り、丁寧に折り畳んだ。 

③ FHO-A型フラスコに脱イオン水 5mL、30%過酸化水素水 4～5滴を入れ、内部を

濡らした。 

④ 白金バスケットをバーナーで焼いた。 

⑤ ろ紙に包んだ sampleを白金バスケットに入れた。 

⑥ 白金バスケットを FHO-A型フラスコにセットし、内部を 30sec酸素置換した。 

⑦ 置換後直ちに活栓と共栓を閉じ外部遮断し、専用クリップで止めた。 

⑧ ワニ口クリップ付きコードをスライダックにつなぎ、ワニ口クリップの両方をフラスコ

の銅線に挟み込んだ。 

⑨ 電圧をかけ sample と濾紙を燃焼させた。 

⑩ 燃焼後フラスコを氷水中に入れ 30min静置した。 

⑪ 静置後、白金バスケット上部のメスピペットに脱イオン水 5.0mL と 99%エタノール

10.0mLを入れ、活栓を開きフラスコ内を洗浄した。 

⑫ フラスコ内を 50%エタノールで洗浄しながら溶液を 50mL メスフラスコに移し、50%

エタノールで正確に 50mL とした。 

⑬ 溶液を 100mLビーカーに移し換え、撹拌しながら 0.02M水酸化ナトリウム水溶液

を滴下し、pH6～7に調節した。 

⑭ 検液を 5.0mLずつサンプル瓶 10本に入れ、0.1% Dimethyl Sulfonazo-III 

Solutionを 2滴ずつ入れた。 

⑮ ビュレットを用い、0.005M塩化バリウム（無水）水溶液で滴定した。溶液色が赤紫

から青緑に変色する点を終点とした。 

⑯ ブランクとして 50%エタノールを 5.0mLずつサンプル瓶 10本に取り、同様の滴定

を行った。 

⑰ 検液の滴定量からブランクの滴定量を引いた値を正味滴定量とし、硫黄の含有率

S(%)を(2)式より求めた。 

 

S(%) =
正味滴定量(mL) ×滴定液濃度(mmol mL)⁄ × S原子量× factor × 100

sample量(mg)
× 100  (2) 
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2-2 インジェクタブルゲルの作製 

2-2-1 CMGゲルの作製 

 作製した CMGを足場材料として使用するためにゲル化を行った。 

Figure 2-1 Lysによる CMG架橋 

 

【試薬】 

 カルボキシメチルジェラン（CMG） （2-1-1により調製） 

 L-Lysine methyl ester: Lys  （ヒドラス化学株式会社） 

 ethyl-3-(3-dimethylaminopropyl) carbodiimide hydrochloride: EDC（ペプチド研究

所） 

 

【使用機器】 

 薬さじ 

 薬包紙（東京日本油紙） 

 電子天秤（SHIMADZU） 

 遠沈管 

 スパチュラ 

 ピペットマン 

 ボルテックス 

 インキュベータ（アズワン株式会社）

 

【手順】 

① 遠沈管に CMG、Lys（CMGのカルボキシメチル基に対して 0.5倍量）、EDC（CMG

のカルボキシメチル基に対して 4倍量）を量り取った。 

② 脱イオン水を加えボルテックスで撹拌した。（脱イオン水に対してCMGが 10wt%に

なるように調製した。） 

③ 均一に溶解した後、37℃で overnight インキュベートした。 
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2-2-2 GS-CMGゲルの作製 

 2-1-1で作成した CMGに対し GSを固定化した硫酸化ネイティブ型ジェラン固定化

カルボキシメチルジェランゲル（GS-CMGゲル）の作成を行った。 

 Figure 2-2に示すように、GSのカルボキシル基と CMGのカルボキシル基を架橋させ

ることによって GSの固定化を行った。 

 

Figure 2-2 Lysによる CMG と GSの架橋 

 

【試薬】 

 カルボキシメチルジェラン（CMG） （2-1-1により調製） 

 硫酸化ネイティブ型ジェラン（GS） （2-1-4により調製） 

 L-Lysine methyl ester  （ヒドラス化学株式会社） 

 1-ethyl-3-(3-dimethylaminopropyl) carbodiimide hydrochloride: EDC（ペプチド研

究所） 

 

【使用器具・機器】 

 薬さじ 

 薬包紙（東京日本油紙） 

 電子天秤（SHIMADZU） 

 遠沈管 

 ピペットマン 

 ボルテックス 

 

【手順】 

① CMG、Lys（CMGのカルボキシメチル基に対して0.5倍量）、EDC（CMGのカル

ボキシメチル基に対して 4倍量）をそれぞれ計り取り、そこに GSを 1wt%になる

ように加えた。 

② 脱イオン水を加えてボルテックスで撹拌し、37℃で overnight インキュベートし

た。 
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2-2-3 ゲルビーズの作製 

 2-2-1および 2-2-2で作製した CMGゲル、GS-CMGゲルをインジェクタブルな材

料にするために細分化しゲルビーズを作製した。 

 

【試薬】 

 CMGゲルまたは GS-CMGゲル（2-2-1および 2-2-2 より作成）、 

 脱イオン水 

 99%エタノール 

 

【使用器具】 

 5mLサンプリングチューブ 

 透析膜 

 シリンジ 

 注射針（20G, 25G） 

 15mL遠沈管 

 

【準備】 

① 作製したゲルを 5mLサンプリングチューブに移し、脱イオン水を加えた。 

② 20Gの注射針で粉砕し、別のサンプリングチューブに移した。 

③ 25Gの注射針で更に粉砕して遠沈管に移した。 

④ 1,000rpm/5minで遠心分離を行い、上澄みを除去した。 

⑤ 遠沈管に 99%エタノールを加えローテーターで 3h撹拌を行った。 

⑥ 1,000rpm/5minで遠心分離を行い、上澄みを除去した。 

⑦ 滅菌水を加え膨潤させた。 

⑧ 無菌状態で 40μmセルストレーナーに通し、40μm未満のゲルビーズを取り除

いた。 

⑨ セルストレーナー上に残ったゲルビーズを遠沈管に移し、滅菌水を加えた。 

⑩ 1,000rpm/5minで遠心分離を行い、上澄みを取り除いた。 

⑪ この操作を 3回行った。 

⑫ 浮遊培養用シャーレにゲルを移し、UV照射を行いながら overnight静置し、滅

菌を行った。 
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2-3 髄核細胞の単層培養における GSの影響 

2-3-1 細胞培養 

 髄核細胞（NP）は三重大学医学部附属病院 外科系診療科 整形外科より提供を

受けたヒト髄核細胞を使用し、提供を受けた段階を passage 1 とした。 

NPは 37℃/5%CO2インキュベータ（池本理化工業）内で培養した。培地はペニシ

リンストレプトマイシン（Sigma）および L(+)-アスコルビン酸（Wako）を添加した。 

DMEM/F-12 1:1（Gibco）を用い、3日に一度培地交換を行った。 

Sub-confluent(70-80%)の状態に増殖した時点でトリプシン処理により継代培養を

行った。 

 

2-3-2 細胞の継代培養 

【準備】 

① 10%FBS / DMEM/F-12(1:1)、滅菌済み PBS を適量用意した。 

② 冷凍保存してある Trypsinを解凍し、10%Trypsin/PBSを適量用意した(以下、ト

リプシン溶液)。 

③ 継代先の培養フラスコに10%FBS / DMEM/F-12 1:1を5mL/25cm2フラスコを入

れ、37℃/5%CO2インキュベータ内でプレインキュベートした。 

 

【細胞の洗浄、剥離】 

① 滅菌済み 10mL ピペットを加熱滅菌後に培養フラスコ内に挿入し、培養液を吸

引、廃棄した。 

② PBS を 5mL/25cm2フラスコ入れ、フラスコ内を洗浄した。 

③ 洗浄液を吸引、廃棄し、トリプシン溶液を 5mL/25cm2フラスコ入れ、37℃

/5%CO2インキュベータ内で 5分程度インキュベートした。 

④ 培養フラスコを揺らす又は叩くことで、フラスコから細胞を剥離させた。 

⑤ 顕微鏡で細胞が剥離したことを確認後、FBSを 1mL/25cm2フラスコ）を加えた。 

⑥ 滅菌済み 10mLピペットで培養フラスコ内の細胞懸濁液を吸引し、15mL遠沈

管に入れた。 

⑦ 遠心機で 750rpm/5min 遠心分離した。 

⑧ 上澄みをピペットで吸引、廃棄し、遠沈管に沈殿している細胞に

DMEM/F-12(1:1)を 1mL又は 3mL加えピペッティングを行い、細胞懸濁液を

作成した。 
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【細胞の播種】 

① 細胞懸濁液濃度を決定した。 

血球計算盤にカバーガラスを載せ隙間に細胞懸濁液 7μLを注入し、顕微鏡

で細胞数を測定し算出した。1mm2の面積の細胞数を数え、液の厚みを0.1mm

としたときの細胞懸濁液濃度を(測定細胞数)×104cells/mL とした。 

② プレインキュベートしておいた培養フラスコに 10,000cells/cm2で播種し、37℃

/5%CO2インキュベータ内で培養した。 

 

2-3-3 髄核細胞の倍化日数 

 継代培養を行った際に細胞数をカウントすることにより、髄核細胞の累積分裂回

数および倍化日数を求めた。 

 累積分裂回数の算出は下式を用いた。 

 

[累積分裂回数] = log2([増殖後の細胞数] [P1の細胞数]⁄ ) 

 

 

 

倍化日数の算出方法は以下に記す。 

 

まず、細胞の増殖について下式が成り立つ。 

[増殖前の細胞数] × 2([培養日数] [倍加日数])⁄ = [増殖後の細胞数] 

 

2を底とする対数を取る。 

 

[培養日数]/[倍加日数] = log2([増殖後の細胞数] [増殖前の細胞数])⁄  

 

これにより、下式を得た。 

[倍化日数] =
[培養日数]

log2([増殖後の細胞数] [増殖前の細胞数])⁄
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2-3-4 髄核細胞の単層培養における形態変化 

NPに GSを添加して単層培養した時の形態の変化を調査した。GSの添加は硫

酸化率 25.44%のGSを濃度 100μg/mLで培地に溶解させたGS添加培地を作製し、

その培地を用いて培養を行った。 

培養を行った細胞は写真を撮影し、その写真を元に細胞面積と真円度を求めた。

細胞面積と真円度の算出には ImageJ を用いて行った。 

 

【細胞面積】 

① 細胞写真を撮影した。 

② 写真中から任意の細胞の輪郭を複数 cells トレースした。 

③ ②で作成した画像を ImageJで開き、[Image]→[Adjust]→[Threshold]により 2値

化を行った。 

④ [Analyze]→[Analyze Particles]により細胞のピクセル数を求めた。 

⑤ スケールバーを読み込み、1ピクセルあたりの大きさを求めた。 

⑥ ④⑤で求めた値より細胞面積を算出した。 

 

【真円度】 

① 細胞写真を撮影した。 

② 写真中から任意の細胞の輪郭を複数 cells トレースした。 

③ ②で作成した画像を ImageJで開き、[Image]→[Adjust]→[Threshold]により 2値

化を行った。 

④ [Analyze]→[Analyze Particles]により出力された結果の Circ.が真円度である。 

 

 

 真円度は正円のときに 1、正円から外れるほど 0に近づく値で、下式により求める

ことができる。 

 

[真円度] =
4π × [面積]

[周長]2
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2-3-5 髄核細胞の単層培養における遺伝子発現 

NPを単層培養した時の遺伝子発現の変化を調査した。同時に複数の硫酸化率

の GSを添加して培養を行うことにより、GSが髄核細胞に与える影響を調査した。 

GS添加は 2-3-4と同条件で、培養容器は 24 wellプレートを用いた。添加培地に

より培養を行った細胞は real-time PCRによりマーカー遺伝子（Col1a1, Sox9, CD90）

の発現を測定した。Sox9を分化マーカーとして利用し、Col1a1およびCD90を脱分

化マーカーとして利用した。内在性コントロールはGAPDHを用いた。PCRにより得

られたデータは ΔΔCt法を用いてノーマライズを行った。 

 

 

Table 2-1 本実験で使用したヌクレオチドプライマー配列 

Target gene  5’→3’ 

GAPDH Force GAT GTC ATC ATA TTT GGC AGG TT 

Reverse CCT GCA CCA CCA ACT GCT TAG CCC 

Col1a1 Force TTT GTG GAC CTC CGG CTC 

Reverse AAG CAG AGC ACT CGC CCT 

SOX9 Force AGT ACC CGC ACT TGC ACA AC 

Reverse TTG TAA TCC GGG TGG TCC TTC 

CD90 Force TGA GAT CCC AGA ACC ATG AAC C 

Reverse TAT TCT CAT GGC GGC AGT CC 
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【ΔΔCt法】 

 

X(A) サンプル Aの内在性コントロール遺伝子 X 

Y(A) サンプル Aのターゲット遺伝子 Y 

X(B) サンプル Bの内在性コントロール遺伝子 X 

Y(B) サンプル Bのターゲット遺伝子 Y 

Figure 2-3 PCRの増幅曲線 

 

Table 2-2 X遺伝子と Y遺伝子に基づく ΔΔCt値 

 X遺伝子の Ct値 Y遺伝子の Ct値 ΔCt値 ΔΔCt値 

サンプル A 15 26 11 
-2 

サンプル B 17 30 13 

 

① 増幅曲線と、横軸との平行線との交点のサイクル数を Ct値とした。 

② 各サンプルのターゲット遺伝子と内在性コントロール遺伝子の Ct値の差を ΔCt

値とした。 

ΔCt = [ターゲット遺伝子の Ct値] − [内在性コントロール遺伝子の Ct値] 

③ ターゲットのサンプル（今回の例ではサンプル B とする）と基準となるサンプル

（今回の例ではサンプル A とする）の ΔCt値の差を ΔΔCt値とした。 

ΔΔCt = [サンプル Aの ΔCt値] − [サンプル Bの ΔCt値] 

④ “1 サイクルの差が 2 倍量の発現量となる”理論を用いて、下式により発現量を

求めた。 

gene expression = 2−ΔΔCt 

 

10 15 20 25 30 35 40

蛍
光
強
度

サイクル数

増幅曲線

Y(B) X(B) 

X(A) Y(A) 
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2-3-6 髄核細胞の単層培養における sGAG産生 

 DMMB法により、単層培養を行なった NPの産生した sGAGの量を測定した。 

 

【試薬】 

 Proteoglycan Detection kit （ASB） 

 

【使用機器】 

 500μLサンプリングチューブ 

 分光光度計 

 

【手順】 

① 段階希釈により 25, 12.5, 6.25, ……, 0.625μg/mLのスタンダード溶液を 100μL

ずつ作製した。 

② サンプルとして培養細胞の上清を 100μL分注した。 

③ 1.9－ジメチルメチレンブルーを全ての溶液にそれぞれ 100μLずつ加えた。 

④ 分光光度計により波長 525nmの吸光度を測定した。 

⑤ スタンダードを作成し、全細胞の sGAG産生量を求めた。 

⑥ ⑤で求めた sGAG産生量を細胞数で割り、1細胞あたりの sGAG産生量を求め

た。 
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2-4 GS-CMGゲルビーズ内培養における NPへの影響 

2-4-1 ゲルビーズ内培養のための培養チャンバーの作製 

 

 

Figure 2-4 培養チャンバー 

 

【手順】 

① Figure 2-4に示す形にアクリル板を加工した。 

② 各部品を滅菌した。 

③ アクリル板の間に透析膜、シリコーンチューブを挟み、ネジで固定した。（Figure 

2-4） 

  

アクリル板 

 

透析膜（分画分子量 1,000,000） 

 

シリコーンチューブ

外φ9mm 

内φ3mm 

M3ネジ 

 

20mm 

10mm 

φ3mm 

7mm 
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2-4-2 GS-CMGゲルビーズ内での細胞培養 

 作製した GS-CMGゲルビーズ内で髄核細胞の培養を行った。 

 

【使用器具】 

 5mLサンプリングチューブ 

 バッド 

 培養チャンバー（2-4-1 より作製） 

 透析膜 

 シリンジ 

 注射針（25G） 

 6wellプレート 

 ドライバー 

 

【手順】 

① 滅菌したゲルビーズ（2-2-3 より）を 5mLサンプリングチューブに移し、プレイン

キュベートした。 

② 6wellプレートに培地 7mLを入れ、プレインキュベートした。 

③ 細胞懸濁液を作製した。（2-3-2 より） 

④ バッド上で培養チャンバーを組み立てた。 

⑤ 所定量の細胞懸濁液をゲルビーズに加え、ゆっくりとピペッティングを行った。 

⑥ シリンジで⑤の細胞懸濁液とゲルビーズの混合物を吸引した。 

⑦ ⑥のシリンジと空のシリンジを装置の穴に差し込んだ。 

⑧ 空のシリンジで装置内を真空にしながらゲルを注入した。 

⑨ ②で用意した 6wellプレートに装置を入れ、培養を行った。 

 

2-4-3 GS-CMGゲルビーズ内で培養した細胞の遺伝子発現 

 ゲルビーズ内で培養した細胞の遺伝子発現量の測定のために real-time PCRを

行った。使用したヌクレオチドプライマーは Table 2-1で示したものである。 

 

2-4-4 GS-CMGゲルビーズ内で培養した細胞の sGAG産生 

 硫酸化グリコサミノグリカン（sGAG）の産生量を測定することで、髄核基質の主要

構成成分である Aggrecanの産生量を調査した。測定には DMMB法を用いた

（2-3-4による）。 
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3. 実験結果 

3-1 CMGの作製 

作製した CMGの 1H-NMRスペクトルを Figure 3-1に示した。1.2ppm付近のラム

ノースのメチル基のプロトンのピーク(a)の積分強度を 3 としてその他のプロトンの積

分強度を求めた。5.0ppm 付近のピーク(b)は α アノマー（1,4-α-L-ラムノース）、

4.4ppm 付近のピーク(c)は β アノマー（1,3-β-D-グルコース、1,4-β-D-グルクロン酸、

1,4-β-D-グルコース）の 1 位の炭素に結合しているプロトンのピークである。4.2～

3.0ppm のピークが 1 位に存在するプロトンとラムノースのメチル基のプロトンを除い

た CMGのプロトンのピークである。 

脱アシルジェラン（DG）は 1 位に存在するプロトンとラムノースのメチル基のプロト

ンを除いた総プロトンの数が 20なので、4.2～3.0ppmの積分強度を 20.00とすると、

作製した CMGのプロトンの同じ範囲での積分強度が 24.64であり、プロトンの積分

強度の増加が見られた。これにより、DG にカルボキシメチル基が導入されたことが

確認された。 

 

以上の結果を用いて、置換度を求めた。 

-OH が-OCH2OO-に置換されるので、置換された部分はプロトン 2 個分増加する

ことから、置換度は下記の式を用いて求めることができる。 

 

 

置換度 = [CMGのプロトンの積分強度− DGのプロトンの積分強度]/2 

 

 

この式より、作製した CMGの置換度は、 

 

24.64 − 20

2
= 2.32 

 

であった。 
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Figure 3-1 カルボキシメチルジェランの 1H-NMR スペクトル 
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3-2 GSの作製 

DMFを溶媒、クロロスルホン酸を酸化剤としてフリー化ネイティブ型ジェランの遊

離の水酸基に対して硫酸化を行った結果を Table 3-1で示す。 

 

Entry Free NG(g) クロロスルホン

酸(mL) 

反応温度

t1, t2(℃) 

収量(g) 硫酸化率(%) 収率

(%) 

1 1.00 3.75 70, 50 0.48 8.57 44.98 

2 1.00 3.75 80, 60 0.76 25.44 71.35 

Table 3-1 作製した硫酸化ネイティブ型ジェラン 

 

反応開始温度および反応温度を低くして作製を行った Entry 1 は硫酸化率

8.57%と硫酸化率の低い GSを得ることができた。 

反応開始温度と反応温度を上げて作製を行った Entry 2 においては硫酸化率

25.44%と、Entry 1 と比較して硫酸化率の高い GSを得ることができた。 

 

3-3 髄核細胞の増殖 

NPの累積分裂回数および倍化日数を算出した結果を示す。 

 

Figure 3-2 髄核細胞の累積分裂回数 
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Figure 3-3 髄核細胞の倍化日数 

 

培養初期段階①においては倍化日数 11 日だが、その後②の段階になると倍化

日数 58日と増殖速度が大きく低下した。 
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3-4 髄核細胞の単層培養における形態変化 

 GS を添加して 7days 培養を行った後の細胞写真を Figure 3-4 に示す。Control

は GSを添加せずに培養を行ったものである。 

 

 

  
Figure 3-4 GS 添加による髄核細胞の形態変化（scale bar = 250µm） 

 

 

Figure 3-4の写真から細胞面積を算出したグラフを Figure 3-5、真円度を算出し

たグラフを Figure 3-6に示す。細胞面積および真円度は GS添加サンプルでは

Figure 3-4中の任意の 47cells、controlでは 31cells より算出した。 

 

 

Figure 3-5 GS添加による髄核細胞の細胞面積 
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Figure 3-6 GS添加による髄核細胞の真円度 

 

 GSの添加により細胞面積が有意に減少し、真円度が有意に増加した。 

 

3-5 髄核細胞の単層培養における遺伝子発現 

髄核細胞を平面足場で所定期間培養を行い、real-time PCR によりマーカー遺

伝子の発現量を測定した結果を示す。 

 
Figure 3-7 Sox9の遺伝子発現 
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Figure 3-8 Col1の遺伝子発現 

 

 

 
Figure 3-9 CD90の遺伝子発現 

 

 

 単層培養を行うことで Sox9 の発現量の減少が見られたが、GS の添加により発

現量減少が抑えられた（Figure 3-7）。脱分化マーカーの Collagen Type I（Figure 

3-8）、CD90（Figure 3-9）は GSを添加することにより発現量の減少が見られた。 
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3-6 髄核細胞の単層培養における sGAG産生 

 1cellあたりの sGAGの産生量を Figure 3-10に示す。 

 

 
Figure 3-10 単層培養における sGAGの産生量 

 

 GS を添加したサンプル（GS）では、添加していないサンプル（control）と比較して

1cellあたりの sGAG産生量が増加した。 
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3-7 GS-CMGゲルビーズ内で培養した髄核細胞の遺伝子発現 

ゲルビーズ内で所定期間培養した髄核細胞のマーカー遺伝子発現量を測定す

るために real-time PCR を行った結果を示す。 

 

 

Figure 3-11 ゲルビーズ内培養による Sox9の遺伝子発現 

 

 
Figure 3-12 ゲルビーズ内培養による Col1の遺伝子発現 
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Figure 3-13 ゲルビーズ内培養による CD90の遺伝子発現 

 

 

 分化マーカーの Sox9 の遺伝子発現は単層培養を行うことで減少が見られたが、

CMGおよびGS-CMGゲルビーズ内での 3D培養では発現量の減少が見られず培

養 0日の発現量を維持した（Figure 3-11）。 

 脱分化マーカーの Collagen Type Iの遺伝子発現は培養 7 日目において CMG

ゲルビーズでは 1.4 倍の増加が見られたが、GS-CMGゲルビーズでは培養 0日の

0.04倍と大幅な減少が見られた（Figure 3-12）。 

 同じく脱分化マーカーの CD90についても培養 7日目において GS-CMGゲルビ

ーズで 0.02 倍と減少が見られた。CMG ゲルビーズ培養では 7 日目に 3.9 倍の発

現量の増加が見られた（Figure 3-13）。 
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3-8 GS-CMGゲルビーズ内で培養した髄核細胞の sGAG産生 

 ゲルビーズ内で培養を行った細胞 1cell あたりの sGAG 産生量を Figure 3-13 に

示す。 

 

 
Figure 3-14 ゲル内培養における sGAG産生量 

 

 

 CMG ゲルビーズ内培養と比較して GS-CMG ゲルビーズの方が 1cell あたりの

sGAG産生量が増加した。 
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4. 考察 

4-1 髄核細胞の増殖 

 本研究で使用した髄核細胞は培養初期段階において、倍化日数 11 日で、その

後倍化日数 58日と増殖速度が低下した（Figure 3-3）。髄核細胞は組織から単離し

て単層培養（2D 培養）を行うと速い速度で増殖し、しばらく経つと増殖速度が落ち

ることが分かる。これは組織中では三次元の環境にある細胞を平面で培養を行うこ

とによって引き起こされた脱分化による形質の変化に由来するものと考えられる。 

 以下にブタ髄核細胞の累積分裂回数（Figure 4-1）および倍化日数（Figure 4-2）

のグラフを示す。ブタ髄核細胞においては、ブタの髄核組織から髄核細胞を単離し

た日を 0日として、Passage 0からのデータを示す。 

 

 

 

Figure 4-1 ブタ髄核細胞の累積分裂回数 

0

1

2

3

4

5

6

7

0 20 40 60 80 100 120 140

累
積
分
裂
回
数

培養日数

ブタNPの累積分裂回数

①

②

R = 0.9990

R = 0.8460



 

42 
三重大学大学院 工学研究科  

 

 

Figure 4-2 ブタ髄核細胞の倍化日数 

 

 

 ブタの髄核細胞においても培養期間が長くなると増殖が遅くなるというヒト髄核細

胞と同様の結果が得られた。今回提供を受けたヒト髄核細胞は既に数回の継代を

経たものであるため、増殖速度の低下がブタ髄核細胞より早い時期に見られる。す

なわち、細胞の提供を受けた時点で既に単層培養による影響を受けていたと考え

られる。 

 以上より髄核細胞は培養初期段階では倍化日数 10 日程度だが培養を進めるに

伴って増殖速度が遅くなることが分かった。臨床で患者の細胞を増殖させることを

考慮すると、正常な髄核細胞が少量しか採取できない患者に対しては増殖に時間

が掛かりすぎることから、増殖因子の添加など培養期間の短縮を考える必要があ

る。 
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4-2 単層培養における GSの髄核細胞に対する作用 

GS の添加により分化マーカーである SOX9（Figure 3-4）の発現の減少が抑制さ

れ、また、脱分化マーカーである Collagen type I（Figure 3-5）および CD90（Figure 

3-6）の発現増加が抑制された。このことより、GSは脱分化した髄核細胞の再分化を

促進させる効果があることが示唆される。 

加えて、以下に軟骨細胞に IL-1βを添加して炎症を誘導することによって脱分化

を引き起こしたモデルを示す[10]。 

脱分化を引き起こした軟骨細胞にコンドロイチン硫酸（CS）を加えることにより、ア

グリカン分解酵素である ADAMTS-4および ADAMTS-5、コラーゲン分解酵素であ

るMMP-13の発現量が減少すると報告されている（Figure 4-3）。また、CS添加によ

り IL-1β 添加による aggrecan の産生減少を抑制する効果も報告されている（Figure 

4-4）。CSは軟骨破壊を促進させる分解酵素の産生を抑えると共に分化状態を維持

することで基質の産生を促進させていると考えることができる。 

 

 
Figure 4-3 コンドロイチン硫酸添加による抗炎症作用[10] 

CS-SC: サメ由来のコンドロイチン硫酸, CS-PC: ブタ由来のコンドロイチン硫酸 
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Figure 4-4 コンドロイチン硫酸添加による aggrecan産生の変化[10] 

 

 

GS は再分化を促進させる効果を有すると共に、CS と同様にこうしたアグリカン分

解酵素やコラーゲン分解酵素の産生を抑え、脱分化を抑制する効果も有すること

が考えられる。 
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4-2-1 bFGFによる応答 

髄核細胞の脱分化を促進する物質として塩基性線維芽細胞増殖因子（basic 

fibroblast growth factor; bFGF）が報告されている。bFGFはMAPK経路の活性化

によりコラーゲン分解酵素である MMP-13 の産生をアップレギュレーションさせ、髄

核の基質の分解を促進させる。また、BMP シグナル経路の活性化を阻害し髄核基

質の産生をダウンレギュレーションさせると報告されている（Figure 4-5）[11]。 

bFGF はヘパリン結合性のタンパク質であることが知られており、また過去の研究

より硫酸化ネイティブ型ジェランとの親和性も報告されている（Table 4-1）[12]。 

 

 
Figure 4-5 bFGFが IVDに与える影響[11] 

 

 

Table 4-1 GS と bFGFの結合定数[12] 

Entry 硫酸化率（％） 結合定数（M） 

1 6.6 5.99E+08 

2 14.8 7.51E+08 

3 20.2 3.30E+08 

4 28.7 9.35E+08 

5 33.6 1.28E+09 
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 bFGFはレセプターである FGFR、細胞表面のヘパラン硫酸プロテオグリカン

（HSPG）のヘパラン硫酸（HS）鎖と bFGF-HS-FGFR三量体を形成することによりシ

グナルが伝達されると考えられている（Figure 4-6）[13]。GSは bFGF と HS鎖の結合

と競合することでbFGF-HS-FGFR三量体の形成を阻害し、bFGFのシグナル伝達を

阻害していると考えられる（Figure 4-7）。変形性関節症の軟骨細胞において膜貫通

型ヘパラン硫酸プロテオグリカンである syndecan-4の発現が報告されており[14]、脱

分化した軟骨細胞では bFGFのシグナルが入りやすくなっていると考えられる。 

 

 

Figure 4-6 bFGF-HS-FGFR三量体形成[13] 

 

 

 

  

Figure 4-7 GSによる bFGF阻害 

GS添加なし GS添加あり 
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 実際に Passage 2のブタ髄核細胞に bFGFを 2ng/mLで添加を行ったところ、線維

芽様の形態を取ったが、100μg/mLで硫酸化率 29.14%のGSを添加したところ本来

の髄核細胞に近い円形の形態を取ることが示された（Figure 4-8）。この画像を元に

真円度を算出したところ、GSの添加により有意に上昇した（Figure 4-9）。真円度の

算出は、bFGFは画像中の任意の 31cells、bFGF+GSは 44cells より算出した。 

これにより、bFGFを添加した細胞においても GSは再分化を誘導していることが

示唆される。 

 

 

 

  

 

  
Figure 4-8 ブタ髄核細胞への bFGF添加（Scale bar 250μm） 

  

培養 0日目 培養 7日目（control） 

培養 7日目（bFGF添加） 培養 7日目（bFGF＋GS添加） 
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Figure 4-9 bFGFおよび GS添加による真円度 

 

 

また、Passage 2のブタ髄核細胞に bFGFを添加して培養を行い、倍化日数を求

めた。添加していないサンプル（control）の倍化日数 17.6日に対し、bFGFを添加し

たサンプルでは 6.0日と短く、増殖能が高いことが分かった（Figure 4-10）。bFGFの

添加により脱分化が進行すると考えられるが、同時に増殖能を高める効果も期待で

きるので、臨床で患者の細胞を増殖させる際に添加することで、培養期間の短縮が

期待できる。 

 

Figure 4-10 bFGF添加による倍化速度 
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4-2-2 BMP-7および nogginによる応答 

軟骨の誘導因子として報告されている骨形成因子 7（bone morphogenetic protein 

7; BMP-7）のアンタゴニストである noggin とヘパリンとの親和性が報告されている[15]。

Nogginの構造は Figure 4-12の白色部分でグリーン部分は BMP-7 を表している。

Noggin は Figure 4-12 の上部の四角で囲まれた部分にヘパリンとの結合部位を持

つ [16]。 
 

 

Figure 4-11 BMP-7による髄核基質産生[15] 

 

 

 

Figure 4-12 nogginの構造[16] 
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Figure 4-13 noggin とヘパリンの結合[16] 

 

 Nogginは細胞表面のプロテオグリカンに補足されており、BMPのシグナルが入る

のを抑制している。細胞から細胞外のプロテオグリカンの硫酸基を分解する細胞外

スルファターゼ（Sulf）により硫酸基とともに切り離されることにより BMP のシグナル

が細胞内に入るようになる[17]。 

 

 

4-2-3 Wntによる応答 

Wnt-3a や Wnt-7a といった Wnt ファミリーのシグナル分子により制御される Wnt

シグナル経路により基質産生が誘導されるといった報告がなされている[18,19]。 

Wnt-3a および Wnt-7a は硫酸化多糖との親和性を持ち、細胞外スルファターゼ

（Sulf）によって細胞外のプロテオグリカンの硫酸基を分解し、プロテオグリカン糖鎖

の硫酸化率を調節することでWntシグナル経路の制御をしていると報告されている。

Wntはヘパラン硫酸（HS）鎖、Wntのレセプターである Frizzled とWnt-HS-Frizzled

三量体を形成してシグナルが ON になると考えられているが、細胞表面のヘパラン

硫酸プロテオグリカン（HSPG）のコンドロイチン硫酸鎖（CS）に結合することで HS と

の結合を阻害し、Wntのシグナルが入るのを抑制している。Sulfが作用するとCSの

硫酸基の分解が起こることにより、CS 鎖に捕捉されていた Wnt が遊離し

Wnt-HS-Frizzled三量体を形成してWnt のシグナルが ONになると考えられている
[20]。 
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Figure 4-14 SulfによるWntシグナルの制御[20] 

 

 

 

Figure 4-15 Wntによる Col2、Sox9の発現抑制[21] 
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4-3 GS-CMGゲルビーズ内培養 

4-3-1 三次元足場の髄核細胞に対する作用 

髄核細胞をゲルビーズ内で培養を行うことにより分化マーカーである SOX9

（Figure 3-11）の遺伝子発現量の維持、ECMである aggrecan（Figure 3-14）の産生

量の増加が見られた。これはゲルビーズ内培養により脱分化が抑制されていること

を意味する。 

軟骨細胞に対して siRNAにより各種 integrinの発現をノックダウンし単層培養を

行ったところ、Figure 4-16に示すように integrin αv（ITGAV）および integrin β5

（ITGB5）をノックダウンしたサンプルにおいて Collagen type IIおよび Aggrecanの

遺伝子発現が増加したと報告されている[22]。また、Figure 4-16に示すように、

integrin αv（ITGAV）および integrin β5（ITGB5）のノックダウンにより線維芽細胞様

への形態変化が抑制されると報告されている。 

 

Figure 4-16 integrinのノックダウンによる軟骨基質の遺伝子発現[22] 

 

 

Figure 4-17 integrinのノックダウンによる形態変化[22] 
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髄核細胞においても単層培養における脱分化に integrin αv および integrin β5

の関与が考えられる。Integrin αvβ5は Type IIB procollagenの N末端ペプチドと結

合するが、正常な軟骨細胞では integrin αvβ5 が発現せず自らの産生した Type II 

collagenの影響を受けないと報告されている[23]。 

本研究で作製した GS-CMG ゲルおよび CMG は細胞接着性を持たないため、

単層培養により発現した integrin αvβ5 に由来するシグナル伝達が抑制され、再分

化へと誘導されたと考えられる。 

 

 

単層培養においても Figure 3-5に示したように GSを添加した髄核細胞において、

細胞面積が減少し、Figure 3-6 に示したように GS 添加により線維芽細胞様の形態

を取らずに髄核本来の円形の形態を取った。また、Figure 4-9 に示したように、GS

は bFGF を添加して増殖能が上がった細胞に対しても円形の形態に変化させる機

能があることが示唆される。 

このことから、GS は髄核細胞の伸展を阻害し、髄核細胞本来の形態である円形

の形態を保たせる効果があることが分かる。Figure 4-17で示した integrin αvおよび

integrin β5 を阻害して単層培養を行った細胞様の形態を取っており、単層培養に

おいても GSには integrinを阻害する機能があることが示唆される。 
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4-3-2 ゲルビーズ内での GSの作用 

Figure 3-11 に示すように、ゲルビーズ内培養によって分化マーカーである Sox9

の発現量は維持されたが、GSを固定化していないCMGゲルでは脱分化マーカー

であるCollagen type I（Figure 3-12）およびCD90（Figure 3-13）の発現量が増加した

のに対し、GS-CMG ゲルでは分化マーカーの発現量維持と脱分化マーカーの発

現量減少が同時に起こり、再分化へ向かっていることが示唆される。 

これはゲルビーズによる三次元培養においても GS の再分化へと誘導する作用

が維持されていることを意味する。 

 

SOX9 

 

Figure 4-20 GS添加による Sox9の遺伝子発現[24] 

 

Figure 4-20で示すように、単層培養を行っている髄核細胞に GS を添加したとこ

ろ、29.14%の GSを添加したサンプルにおいて Sox9の発現量が増加したことから、

硫酸化率 30%前後の GSが最も再分化を促進させる作用が強いと考えられる。 
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Figure 4-21 GSの髄核細胞への作用 

 

 GS は細胞表面のヘパラン硫酸プロテオグリカン（HSPG）と複合体を形成すること

でシグナルが伝達され脱分化が進行するbFGFやWntと競合することで、脱分化が

進行するシグナルの伝達を阻害していると考えられる。また、noggin と細胞表面の

プロテオグリカンとの結合と競合することで noggin の細胞表面への凝集を阻害し、

分化を誘導する BMP-7のシグナルが伝達されたと考えられる（Figure 4-21）。 

 

 

  

Figure 4-22 GS-CMGゲルビーズの髄核細胞への作用 

 

GS-CMGゲルビーズは硫酸化多糖と親和性を持つ分子を吸着させる作用がある

と考えられる。その中で髄核細胞の分化・脱分化に関与していると考えられる bFGF

や Wnt、noggin などが細胞周囲のゲルビーズに吸着することでそれらの細胞周囲

の濃度が変化し、細胞を分化誘導したと考えられる（Figure 4-22）。 

  

CMGゲルビーズ GS-CMGゲルビーズ 

GS添加なし GS添加あり 
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4-4 椎間板修復材料 

本研究で作製したGS-CMGゲルビーズはシリンジにより容易にインジェクトできる

材料であり、これを用いることで現在行われている手術療法のような広範囲の切開

は不要となり低侵襲な治療を行うことができると期待される。また、患者自身の細胞

を用いた治療となるので拒絶反応が起こりにくく、より安全な治療が可能になると考

えられる。 

GS-CMGゲルビーズに脱分化した髄核細胞を混和し、椎間板組織を模した培養

チャンバーにインジェクトして培養を行うことで再分化が確認されたことから、生体へ

のインジェクトにより治療を行うことが可能である材料であることが期待できる。 

実際に治療を行うにあたり問題となるのが、髄核細胞の増殖能の低さによる治療

期間の長期化である。この問題の改善策として培地への bFGFの添加が考えられる。

bFGF添加により増殖能の上昇が見られ、また bFGF を添加した髄核細胞において

もGSの効果が見られたことから、患部から採取した髄核細胞に bFGFを添加して早

急に増殖させ、GS-CMGゲルビーズに混和してインジェクトを行うことで短期間の治

療が可能になることが期待できる。 

 

 

 

Figure 4-23 本研究で目指す治療法 
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5. 結論 

 

以下、本研究において得られた結論を記載する。 

 

 

 硫酸化ネイティブ型ジェランは脱分化した髄核細胞を再分化誘導する作用が

あることが判明した。 

 髄核細胞の再分化に適した材料として硫酸化ネイティブ型ジェラン固定化カル

ボキシメチルジェランゲルビーズの開発に成功した。 
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